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ELV-Modulsystem + Arduino -
die Verschmelzung zweier Welten

Die Verschmelzung zweier Welten war immer schon begeisternd. Sie ist ein Nahrboden fiir neue Ideen
und eine treibende Kraft in Bezug auf kreatives Denken. Durch die Kombination vordefinierter Elek-
tronikbausteine lassen sich neue Gerate- bzw. Produktideen auf schnellstem Wege realisieren. Man
nehme ELV Basismodul A, fiige ELV Applikationsmodul B hinzu, kombiniere dies mit der Arduino IDE
und versorge alles mit intelligentem Programmcode. Et voila, ein lang gehegter Geratewunsch erfiillt
sich. Durch die Arduino IDE, die ELV Basis- und Applikationsmodule sowie die online verfiigbaren Pro-
grammbeispiele und -bibliotheken wird man in die Lage versetzt, den Entwicklungsaufwand eines
Gerats deutlich zu vereinfachen und zugehérige Entwicklungszeiten drastisch zu verkiirzen. So sind
der Vorstellungskraft keine Grenzen gesetzt.

ARDUINO
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Motivation

Mit der Integration des ELV-Modulsystems in die Arduino-Umgebung
werden vielfaltige Moglichkeiten geschaffen, um das ELV-Modulsys-
tem auf personliche Bedirfnisse zuzuschneiden. Dieser Artikel soll
eine Installationsanleitung sein sowie einige Codebeispiele und Denk-
anstoBe geben, um eine Applikation unter Zuhilfenahme der Arduino
IDE zu entwerfen.

Anleitung

Um die ELV LoRaWAN®-Base mit der Arduino IDE verwenden zu kon-
nen, muss zunachst das STM32duino-Paket in der Arduino-Entwick-
lungsumgebung installiert werden. Hierzu navigiert man im Mentband
der Arduino-IDE-Applikation zunachst auf File und dann zu Preferen-
ces...,umin das Einstellungsfenster zu gelangen (Bild 1).

Innerhalb der Einstellungen befindet sich am unteren Ende des
Fensters ein Feld mit der Beschriftung Additional Board Manager
URLs. An dieser Stelle muss die URL eingetragen werden, damit das
STM32duino-Paket installiert werden kann(Bild 2). Bei Bestatigung mit
OKwird die Optionder Boardsin den Arduino-Board-Manager eingetra-
gen(Bild 3).

Bei den Board-Definitionen handelt es sich um eine Auflistung ver-
schiedener Microcontroller-Platinen und deren Eigenschaften. Einige
Hersteller haben z. B. aus Platzgriinden nicht alle Anschlusspins des
verwendeten Microcontrollers nach auBen zuganglich gemacht oder
Uber bestimmte Beschaltungselektronik einige Funktionen von Pins
bevorzugt bzw. unterbunden. Mit der Auflistung dieser Elemente wird
somit gewahrleistet, dass jeder Eintrag auch mit dem verwendeten
Code funktionieren kann.

Um die Board-Definitionen tatsachlich herunterzuladen, muss in
der Seitenleiste der Entwicklungsumgebung auf das Platinensymbol
geklickt werden, um den Board-Manager zu 6ffnen. Hierzu wird in der
Suchleiste der Suchbegriff ,STM32 MCU based boards” eingegeben.
Beim entsprechenden Eintrag kannim Drop-down-Menu der Versionen
mindestens die Version 2.8.1ausgewahlt werden.

Bild 2: Im Feld
,Additional boards
manager URLs”
muss die Adresse
eingegeben werden.

Bild 1: Das Einstellungsmend ist im Meniband unter ,File” zu finden.

Hinweis:
Umdie Bibliothek verwenden zu konnen wird zusatz-
lich noch das Programm STM32CubeProgrammer
bendtigt.
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Bild 3: Die Board-Manager-Liste unter dieser URL-Adresse wird von STMicroelectronics stets aktuell gehalten.

Mit einem Klick auf Install werden die Board-De-
finitionen in die Entwicklungsumgebung Ubernom-
men (Bild 4).

Nach der erfolgreichen Installation kann die
ELV LoRaWAN®-Base uber das MenU ausgewahlt
werden. Dies geschieht wie in Bild5 dargestellt
Uber Tools > Board > STM32 MCU based boards >
ELV Modular System boards.

Wenn das System ausgewahlt wurde, kann unter Tools > Board part
numberdie ELV LoRaWAN®-Base ausgewahlt werden. Spatestens jetzt
sollte sie auch per USB-C Kabel angeschlossen werden. Nun kann im
Windows-Geratemanager der COM-Port der Base ermittelt werden,
wie in Bild 6 zu sehen ist. Dieser Port wird nachfolgend in der Arduino
IDE angegeben.

Zuletzt muss unter Upload method der Eintrag SMT32CubeProgram-
mer (Serial) with Bootloader angewahlt werden.

Bild 4: Nach erfolgreicher Installation sind die STM32-Board-Definitionen im Board-Manager der Arduino IDE zu finden.
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https://github.com/stm32duino/Arduino_Core_STM32/wiki/Getting-Started#installing-stm32-cores

Bild 5: Nach erfolgreicher Installation kann nun der Eintrag der ,ELV-modular-system”-Boards im Board-Men( gefunden werden.

Steht ein STLink-Programmer zur Verflgung,
kann der Eintrag SMT32CubeProgrammer (SWD) with
Bootloader verwendet werden. Hierfir muss dann
SWDIO vom STLink mit Pin 18 und SWDCLK mit Pin 17
sowie GND mit Pin 16 und VDD mit Pin 15 verbunden
werden.

Die korrekten Einstellungen zum Bespielen der
ELV LoRaWAN®-Base sind in Bild 7 zusammenfas-
send dargestellt.

Nach dieser Einrichtung kann der erste Pro-
grammcode geschrieben werden, um die Installati-
on zu prifen. Hierzu kann das Blink.ino-Beispiel mit
minimaler Anderung verwendet werden.

Um einen leichten Einstieg zu vollziehen, bietet
es sich an, zunachst eine LED zum Blinken zu brin-
gen. Das zugehorige Programm ist verhaltnismaBig
einfach. Die LED ist an einem bestimmten Pin ange-
schlossen. Dieser Pin muss zunachst als Ausgang
initialisiert werden. Danach muss der Pin zwischen
dem Logiklevel ,HIGH" und ,LOW" wechseln. Damit
der Einschaltvorgang fir das menschliche Auge
sichtbar wird, muss die Einschaltdauer auf einen
wahrnehmbaren Zeitwert eingestellt werden.

Das Beispielprogramm ist im Menl unter File >
Examples > 01. Basics - Blink zu finden. Die Anpas-
sungen im Programmcode sind im Bild Codeblock 1
zu finden.

Bild 6: Der COM-Port kann im Windows-Gerdtemanager nachge-
schaut werden.

Alle Programmcodes finden Sie auch als Source-Datei
im ELVshop bei diesem Fachbeitrag unter Downloads.
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Projekt

Auto Format
Archive Sketch
Manage Libraries...
Serial Monitor

Serial Plotter

Firmware Updater
Upload SSL Root Certificates

Board: "ELV Modular System boards”
Port: "COMS5"
Get Board Info

Debug symbols and core logs: "None"

Optimize: "Smallest (-Os default)*

Board part number: "ELV-LW-Base ELV_BM_TRX1"
C Runtime Library: "Newlib Nano (default)"

Upload method: "STM32CubeProgrammer (Serial) with Bootloader”

U(S)ART support: “Enabled (generic "Serial’)"

Burn Bootloader

Codeblock 1
void setup() {

pinMode (LED_BUILTIN, OUTPUT);
}

void loop() {
digitalWrite(LED_BUILTIN, LOW);
delay(1000);
digitalWrite(LED_BUILTIN, HIGH);

delay(1000);
}

Ob der Programmcode Syntaxfehler hat, kann mit-
hilfe des Verify-Buttons anhand des Hakchen-Sym-
bols geprift werden (Bild 8). Dieser gibt bei erfolg-
reicher Kompilierung tUber die Konsole im unteren
Fensterbereich Auskunft dariber, wie viel Speicher-
platz das aktuelle Programm benétigt (Bild 9).

Flashen

Bevor der Programmcode auf die LoRaWAN®-Base
Ubertragen werden kann, muss diese in den Boot-
loader-Modus gebracht werden. Dies geschieht, in-
dem man beim Zufiihren der Spannungsversorgung
die Taste S1gedriickt halt. Wenn der Bootloader ak-
tiv ist, blinkt die rote LED an DS2 fir eine Sekunde
auf. Umden Flash-Vorgang zu starten, muss auf den
Button mit dem Pfeil nach rechts (Bild 8) gedriickt
werden. Nach dem erfolgreichen Flashen des Ge-
rats beginnt die ELV LoRaWAN®-Base mit der Aus-
flihrung des Programms (Bild 9). Die griine LED an
DS2 sollte nun im Sekundentakt blinken gemaB den
im Codeblock 1definierten Vorgaben.
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Bild 7: Die korrekten Programmier-
einstellungen
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Bild 8: Die Schaltflichen zum
Verifizieren, Ubertragen und
Debuggen der Firmware.

Verwendung von Spezialfunktionen

Eine Besonderheit des auf der ELV LoRaWAN®-Base verwen-
deten Funkmoduls ist der sehr energiesparende Low-Power-
Modus. Um die darin enthaltenen Funktionen verwenden zu
konnen, muss die Entwicklungsumgebung um eine Bibliothek
erweitert werden. Eine solche Bibliothek stellt eine Sammlung
von Programmcodes dar, die Gber programminterne Funktio-
nen abrufbarist. Die Bibliothek, die die Low-Power-Funktionen
verwendbar macht, heiBt STM32LowPower. Hier ist in der Be-
schreibung gesondert darauf zu achten, dass eine Abhangig-
keit zu einer anderen Bibliothek besteht. Um die Low-Power-
Funktionen verwenden zu kénnen, muss die Real-Time-Clock
des Controllers verwendet werden, da die anderen Timer im
Low-Power-Modus abgeschaltet werden. Die Bibliothek, die
diese Funktionalitat bereitstellt, heiBt STM32RTC. Das Installie-
ren einer Bibliothek ist immer identisch und wird im Folgenden
beschrieben.

Auf der Hauptseite der Bibliothek kann im rechten oberen
Bereich der griine ,.<> Code"-Button (siehe Bild 10) geklickt wer-
den, wodurch sich ein Drop-down-Men( 6ffnet, das die Option
Download ZIP verfligbar macht (Bild 11).



https://github.com/stm32duino/STM32LowPower
https://github.com/stm32duino/STM32RTC

Sketch uses 12832 bytes (9%) of program storage space. Maximum is 129024 bytes.
Global variables use 1228 bytes (2%) of dynamic memory, leaving 47924 bytes for local variables. Maximum is 49152 bytes.

Serial Port COM5 is successfully opened.

Port configuration: parity = even, baudrate = 11520, data-bit = 8,
| | | } [ | | | | | |5t0p-bit = 1.0, flow-control = off
Activating device: OK

Board HEE

Chip ID: @x497

BootLoader protocol version: 3.3

Device name : STM32WLxX

Flash size : 256 KBytes (default)

Device type : MCU

Revision ID : --

Device CPU : Cortex-M4

Memory Programming ...

Opening and parsing file: Blink.ino.bin
File : Blink.ino.bin
Size : 12.86 KB
Address : Ox08000800

Erasing memory corresponding to segment ©:
Erasing internal memory sectors [1 7]
Download in Progress:

File download complete
Time elapsed during download operation: ©0:00:02.014

RUNNING Program ...
Address: : 9x8000800
Start operation achieved successfully

Bild 9: Wahrend der Programmtubertragung wird man von der Arduino IDE dariiber informiert, welcher Prozess in Bearbeitung ist.

Bild 10: Alle Bibliotheken, die flr das
Programmieren der ELV LoRaWAN®-Base
notwendig sind, sind im github von

zu finden.
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Bild 11: Um externe Programmbibliotheken verwenden zu kénnen, muss als erster Schritt der Programmcode als ZIP-Archiv von github heruntergeladen werden.

Um die ausgewahlte Bibliothek innerhalb der Arduino
IDE verwenden zu kénnen, muss im Menl die Option
Sketch > Include Library - Add .ZIP Library gewahlt
werden. Dadurch 6ffnet sich ein Dateiauswahldialog,
in dem die heruntergeladenen ZIP-Archive ausgewahlt

Bild 12: Der zweite Schritt zur Verwendung externer Bibliotheken ist das
Einfligenin die Arduino-Entwicklungsumgebung.
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werden kénnen (Bild 12). Sobald die STM32RTC und die STM32Low-
Power hinzugefligt worden sind, kann ein erneutes Programmbei-
spiel verwendet werden.

Das Programmbeispiel Codeblock 2 ist unter File » Examples >
STM32duino Low Power > TimedWakeup zu finden. Die erforderli-
chen Anpassungen sind ahnlich zu denen im Beispiel Codeblock 1.

Nach dem Kompilieren und Hochladen des Programms andert
sich nichts am sichtbaren Verhalten des Gerats. Betrachtet man
allerdings den Stromverbrauch, ist erkennbar, dass in den Deep-
Sleep-Phasen nur noch ein Strom von 2,5 pA flieBt. Im Vergleich zu
den 3,4 mAim Normalmodus ist dies eine deutliche Verbesserungin
etwaum den Faktor 1000.

Codeblock 2

#include "STM32LowPower.h"

void setup() {
pinMode (LED_BUILTIN, OUTPUT);

LowPower.begin();

}

void loop() {
digitalWrite(LED_BUILTIN, HIGH);
LowPower.deepSleep(1000);
digitalWrite(LED_BUILTIN, LOW);
LowPower.deepSleep(1000);

}



Projekt n

Codeblock 3

//Die Bibliothek wird lber die include-Direktive eingefiihrt
#include <STM32LoRaWAN.h>

STM32LoRaWAN modem; //ein Objekt fir die Verwendung der Bibliothek

static const unsigned long TX_INTERVAL = 60000; /* ms */
unsigned long last_tx = 0;

/* Get the rtc object */
STM32RTC& rtc = STM32RTC::getInstance(); //Ein Objekt fur die Realtime Clock
instantiiert

void setup() {
Serial.begin(115200);
Serial.println("Start");
modem.begin(EU868);

// Hier wird die Join-Methode ausgewdhlt, die Verwendung mit TTN bendtigt
die OTAA (Over the Air Authentification) . Die Gruppen von Nullen wird ersetzt
durch die JoinEUI, AppKey und DevEUI der LoRaWAN Base. Diese koénnen iliber den
mitgelieferten QR-Code Sticker oder das ELV Flasher Tool ermittelt werden

bool connected = modem.joinOTAA(/* JoinEui */ "©000000000000000", /* AppKey

¥/ ", /* DevEui */ "0000000000000000") ;
//bool connected = modem.joinABP(/* DevAddr */ "00000000", /* NwkSKey */
" 2] 2] 00", /* AppSKey */

0 o )s

if (connected) {
Serial.println("Joined");

} else {
Serial.println("Join failed");
while (true) /* Endlosschleife */

} //Wenn die Verbindung erfolgreich war, wird das Programm fortgefiihrt, wenn
es nicht erfolgreich war, bleibt es stehen

/* set the calendar */
rtc.setTime(00, 00, 00); //Hier kann die aktuelle Uhrzeit eingetragen werden
rtc.setDate(04, 07, 23); //Hier kann das aktuelle Datum angegeben werden

}

void send_packet() {

char payload[27] = { @ }; /* Die Lange des Pakets */

/* Hier wird das Paket erstellt - mit dem Datum und der Uhrzeit */

sprintf(payload, "%02d/%02d/%04d - %02d:%02d:%02d",
rtc.getMonth(), rtc.getDay(), 2000 + rtc.getYear(),
rtc.getHours(), rtc.getMinutes(), rtc.getSeconds());

modem.setPort(10);

modem.beginPacket();

modem.write(payload, strlen(payload));

if (modem.endPacket() == (int)strlen(payload)) {
Serial.println("Sent packet");
} else {
Serial.println("Failed to send packet");
¥
//Nach Senden des Pakets wird lberprift, ob ein Downlinkpaket empfangen
wurde
if (modem.available()) {
Serial.print("Received packet on port ");
Serial.print(modem.getDownlinkPort());
Serial.print(":");
while (modem.available()) {
uint8_t b = modem.read();
Serial.print(" ");
Serial.print(b >> 4, HEX);
Serial.print(b & ©xF, HEX);
}
Serial.println();
}
}

void loop() {
//Wenn das letzte Paket ldnger her ist, als der TX_INTERVAL, dann
schicke ein neues Paket
if (!last_tx || millis() - last_tx > TX_INTERVAL) {
send_packet();
last_tx = millis();
¥
}

LoRaWAN®

Das wichtigste Herausstellungsmerkmal der ELV
LoRaWAN®-Base ist die LoRaWAN®-Funktionalitat.
Um diese verwenden zu konnen, wird die Bibliothek
STM32LoRaWAN bendtigt. Diese ist ebenfalls von
der STM32RTC-Bibliothek abhéngig, die bereits im
vorherigen Schritt installiert wurde.

Nach der Installation der STM32LoRaWAN®-
Bibliothek kann das Programmbeispiel Codeblock 3
verwendet werden, um die LoRaWAN®-Funktion
Uberprifen zu kdnnen. Hierbei ist darauf zu achten,
anstelle der Nullen die Keys der ELV LoRaWAN®-
Base einzusetzen.

Die ELV LoRaWAN®-Base kann nun wie im Fach-
beitrag zur ELV-LW-Base beschrieben mithilfe der
gleichen Keys registriert werden. Um die Daten in-
nerhalb des TTN-Netzwerks auslesen zu konnen,
muss dort in der Oberflache ein Payload-Parser
definiert werden. Der Code fur das Umwandeln von
Hexadezimalwerten zurlick in ASCII-Zeichen ist in
Codeblock 4 dargestellt. Dieser Code wird im TTN
als Uplink-Payload-Parser entweder fir die gesam-
te Applikation oder das einzelne Endgerat eingeflgt.

Codeblock 4

function Decoder(bytes, port
// Decode plain text; for testing only
return

myTestValue fromCharCode.apply(null, bytes
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n Projekt
Bild 13: Die fir das Modul ELV-AM-AP

Verwendung mit Applikationsmodulen benétigte Bibliothek
des ELV-Modulsystems
Nachfolgend wird das Vorgehen zur Verwendung
verschiedener ELV-Applikationsmodule erklart, bei-
spielhaft anhand des ELV-Applikationsmoduls Luft-
druck ELV-AM-AP. An dieser Stelle erfolgt allerdings
keine Schritt-fir-Schritt-Anleitung, sondern ledig-
lich ein Uberblick, um ein grundlegendes Gefiihl fir
das notwendige Vorgehen zu vermitteln. Dazu wird
im Library-Manger der Arduino-Entwicklungsumge-
bung nach der Teilenummer des auf dem ELV-Appli-
kationsmodul verbauten Sensors gesucht. Fur das
Beispiel des ELV-AM-AP ist dies der Sensor BMP581
von Bosch Sensortec. Um den Library-Manager zu
verwenden, muss in der Seitenleiste der Arduino
IDE auf das Bibliotheksmanager-lcon geklickt wer-
den. In der Suchleiste kann anschlieBend nach der
Bezeichnung des Sensors gesucht werden, wie in
Bild 13 zu sehen.
Nach der Installation dieser Bibliothek stehen Codeblock5
Programmbeispiele des BMP581zur weiteren Verfi-
gung. Unter File > Example > Sparkfun BMP581 Ardu- e e epsE1. Arduino Library.h"
ino Library - Examplel_BasicReadingsI2C kann man
sich einen Uberblick dariiber verschaffen, wie diese BMPS81 pressureSensor;
Bibliothek arbeitet. Von besonderer Bedeutung sind
hierbei die #include-Direktiven, Initialisierungen

SOWie daS AUSlesen der MeSSWerte Verdeut”cht uint8_t i2cAddress = BMP581_I2C_ADDRESS_SECONDARY;

wird diesin Codeblock 5. void setup()
Alle Codeblocks dieses Betrags kdnnen zu einem {
neuen Programm zusammengefiihrt werden. Dies Serial.begin(115200);

L. ) Serial.println("BMP581 Examplel begin!");
wird in Codeblock 6 veranschaulicht.

Zudem ergeben sich durch die Integration der
ELV LoRaWAN®-Base einige weitere Mdglichkeiten,

Wire.begin();

um das ELV_MOdUlSyStem in Spannende” Projekten while(pressureSensor.beginI2C(i2cAddress) != BMP5_OK)
einzusetzen. Es kdnnen mehrere ELV-Applikations-
module zusammengesteckt verwendet werden, wo- Serial.println("Error: BMP581 not connected, check wiring and I2C

durch der Kreativitit unserer Leser kaum Grenzen address!™);

gesetzt sind.

Ein interessantes Beispiel ist die Realisation ei-
ner eigenen Schaltaktorik, die man mithilfe eines
Step-up-Spannungswandlers, des ELV Bausatzes }
Relais-Schaltmodul ELV-RSMI und eines zum Ver-
braucher passenden Relais erstellt.

Neben der Einbindung von ELV-Applikationsmo- bmps_sensor_data data = {0,0};
dulen kénnen auch viele individuelle Schaltungen intg t err = pressureSensor.getSensorData(&data);
mithilfe der ELV Prototypenadapter entwickelt wer-
den. Hierzu wird esinden kommenden ELVjournalen

delay(1000);

Serial.println("BMP581 connected!");

void loop()

if(err == BMP5_0K)

{
weitere spannende Projekte geben.

Serial.print("Temperature (C): ");
Serial.print(data.temperature);
Serial.print("\t\t");
Serial.print("Pressure (Pa): ");
Serial.println(data.pressure);

}

else

{
Serial.print("Error getting data from sensor! Error code: ");
Serial.println(err);

}

delay(1000);
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Projekt

Codeblock 6

#include <STM32LoRaWAN.h>

#include <STM32LowPower.h>

#include <Wire.h>

#include "SparkFun_BMP581_Arduino_Library.h"

STM32LoRaWAN modem;

// Create a new sensor object
BMP581 pressureSensor;

// I2C address selection
uint8_t i2cAddress = BMP581_I2C_ADDRESS_SECONDARY; // 0x46

static const unsigned long TX_INTERVAL = 60000; /* ms */
unsigned long last_tx = 0;
unsigned int counter = @;

/* Get the rtc object */
STM32RTC& rtc = STM32RTC::getInstance();

void setup() {
LowPower.begin();
Serial.begin(115200);
Serial.println("Start");
modem.begin(EU868) ;

// Configure join method by (un)commenting the right method

// call, and fill in credentials in that method call.

bool connected = modem.joinOTAA(/* AppEui */ "00000000000000", /* AppKey */
" ", /* DevEui */ "00000000000000");

//bool connected = modem.joinABP(/* DevAddr */ "00000000", /* NwkSKey */
" ", /* AppSKey */
" ")s

if (connected) {
Serial.println("Joined");

} else {
Serial.println("Join failed");
while (true) /* infinite loop */

B

Wire.begin();

/* set the calendar */
rtc.begin(true);
rtc.setTime(00, 00, 00);
rtc.setDate(00, 00, 00);

while(pressureSensor.beginI2C(i2cAddress) != BMP5_OK)

{
// Not connected, inform user
Serial.println("Error: BMP581 not connected, check wiring and I2C
address!");

// Wait a bit to see if connection is established
delay(1000);

Serial.println("BMP581 connected!");

void send_packet() {
counter++;
bmp5_sensor_data data = {0,0};
int8_t err = pressureSensor.getSensorData(&data);

Serial.println(data.temperature);

Serial.println(data.pressure);

char payload[50] = { @ }; /* packet to be sent */

/* prepare the Tx packet : get date and format string */

String temp = String(data.temperature);

String pres = String(data.pressure);

sprintf(payload, "#%d: %02d/%02d/%04d - %02d:%02d:%02d: %s C %s Pa",
counter,
rtc.getMonth(), rtc.getDay(), 2000 + rtc.getYear(),
rtc.getHours(), rtc.getMinutes(), rtc.getSeconds(), temp.c_str(),

pres.c_str());

modem.setPort(10);

modem.beginPacket();

modem.write(payload, strlen(payload));

if (modem.endPacket() == (int)strlen(payload)) {
Serial.println("Sent packet");

} else {
Serial.println(“"Failed to send packet");

}

if (modem.available()) {
Serial.print(“Received packet on port ");
Serial.print(modem.getDownlinkPort());
Serial.print(":");
while (modem.available()) {
uint8_t b = modem.read();
Serial.print(" ");
Serial.print(b >> 4, HEX);
Serial.print(b & OxF, HEX);
¥
Serial.println();
}
Serial.flush();

}

void loop() {
send_packet();
LowPower.deepSleep(TX_INTERVAL);
Serial.begin(115200);
Wire.begin();
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